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Conventions used in this guide

> TIP: Tips provide helpful hints or shortcuts.
Bf NOTE: Notes provide important information to explain a concept or to complete a task.

/A CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging the
product.

A WARNING! Warnings alert you to specific procedures that you should follow to avoid personal injury,
catastrophic loss of data, or extensive damage to the product.
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Product comparison

HP LaserJet Professional P1100 Printer series HP LaserJet Professional P1100w Printer series

o Speed: Up to 18 A4 pages per minute (ppm), 19 letter- | «  Speed: 18 A4 pages per minute (ppm), 19 letter-size ppm

size ppm
e  Trays: 150-sheet main-input tray and 10-sheet priority
e  Tray: 150-sheet input tray input slot
o  Connectivity: Hi-Speed USB 2.0 port e  Connectivity: Hi-Speed USB 2.0 port and 802.11b/g

wireless networking
o  Duplexing: Manual duplexing (using the printer driver)
e  Duplexing: Manual duplexing (using the printer driver)

Environmental features

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Save energy with product Auto-Off mode.

Duplex Save paper by using the manual duplex printing setting.

HP Smart Web Printing  Use HP Smart Web Printing to select, store, and organize text and graphics from multiple Web
pages and then edit and print exactly what you see onscreen. It gives you the control you need for
printing meaningful information while minimizing waste.

Download HP Smart Web Printing from this Web site: www.hp.com/go/smartweb.
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Benefit

Supporting features

Excellent print quality

Genuine HP print cartridge.

FastRes 600 setting provides 600 dots per inch (dpi) effective print quality. FastRes 1200
setting provides 1,200 dpi effective print quality.

Adjustable settings to optimize print quality.

Supported operating
systems

Windows Vista (32-bit and 64-bit)
Windows XP (32-bit and 64-bit)
Windows 7

Windows Server 2003 (32-bit and 64-bit)
Windows Server 2008 (32-bit and 64-bit)

Mac OS X v10.4, v10.5, v10.6

Ease of use

HP Smart Install feature installs product software when you connect a USB cable between
the product and a Windows computer.

The print cartridge is easy to install.
Convenient access to the print cartridge and to the paper path through the print-cartridge door.

Paper tray can be adjusted with one hand.

Flexible paper handling

A 10-sheet priority input slot (wireless models only)
A 150-sheet (75 g/m? (20 Ib) paper) input tray.
A 125-sheet (75 g/m? (20 Ib) paper) output bin.

Manual duplexing (two-sided printing).

Interface connections

Hi-Speed USB 2.0 port

802.11b/g wireless networking (wireless models only)

Energy savings

After a user-specified time, the Auto-Off feature automatically conserves electricity by
substantially reducing power consumption when the product is not printing.

Economical printing

N-up printing (printing more than one page on a sheet) and the manual two-sided printing
features save paper.

EconoMode printer driver feature saves toner.

Supplies management

Authentication for genuine HP print cartridges.
Easy ordering for replacement supplies.

Supplies status page shows estimated toner level in the print cartridge. Not available for non-
HP supplies.

Accessibility e The online user guide is compatible with text screen-readers.
e Alldoors and covers can be opened by using one hand.
Security e Kensington lock receptacle on the back of the product.
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Product views

Front and left side view

Table 1-1 HP LaserJet Professional P1100 Printer series

1

Output bin

2

Foldable output tray extension

3

Input tray

Short media extender tool

Power button

Print-cartridge door lift-tab

Control panel

Chapter 1 Product basics
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Table 1-2 HP LaserJet Professional P1100w Printer series

1 Output bin

2 Foldable output tray extension
3 Priority input slot

4 Main input tray

5 Power button

6 Print-cartridge door lift-tab

7 Control panel

Product views
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Back view

1 USB port

2 Power connector

3 Kensington lock

Serial number and product number location

The label that contains the product number and serial number is on the rear of the product.

6 Chapter 1 Product basics ENWW



Control-panel layout

Bf NOTE: See Interpret control-panel light patterns on page 70 for a description of what the light
patterns mean.

Table 1-3 HP LaserJet Professional P1100 Printer series

1 Attention A\ light: Indicates that the print cartridge door is open or other errors exist.

2 Ready () light: When the product is ready to print, the ready light is on. When the product is processing data, the ready
light blinks.

Table 1-4 HP LaserJet Professional P1100w Printer series

1 Wireless (t) button: To detect wireless networks, press the wireless button. This button also enables and disables the
wireless feature.

2 Wireless light: When the product is searching for a network, the wireless light blinks. When the product is connected to
a wireless network, the wireless light is on.

3 Attention A\ light: Indicates that the print cartridge door is open or other errors exist.

ENWW Product views 7



Table 1-4 HP LaserJet Professional P1100w Printer series (continued)

4 Ready Q) light: When the product is ready to print, the ready light is on. When the product is processing data, the ready
light blinks.

5 Cancel X button: To cancel the print job, press the cancel button. Press and hold the button for 5 seconds to print a
configuration page.
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e Supported operating systems for Windows

° Supported printer-drivers for Windows

° Priority for print settings

° Change printer-driver settings for Windows

° Remove software for Windows

e  Supported utilities (wireless models only)




Supported operating systems for Windows

The product comes with software for the following Windows® operating systems:

Windows Vista (32-bit and 64-bit)
Windows XP (32-bit and 64-bit)
Windows 7

Windows Server 2003 (32-bit and 64-bit)

For more information about upgrading from Windows 2000 Server to Windows Server 2003, using
Windows Server 2003 Point and Print, or using Windows Server 2003 Terminal Services and
Printing, go to www.microsoft.com.

Windows Server 2008 (32-bit and 64-bit)

Supported printer-drivers for Windows

The product comes with software for Windows that allows the computer to communicate with the
product. This software is called a printer driver. Printer drivers provide access to product features, such
as printing on custom-sized paper, resizing documents, and inserting watermarks.

Bf NOTE: The most recent drivers are available at www.hp.com/support/lip1100series. Depending on
the configuration of Windows-based computers, the installation program for the product software
automatically checks the computer for Internet access in order to obtain the latest drivers.

In addition to the printer driver that is installed during the HP Smart Install or from the product CD, the
XML Paper Specification (XPS) driver is available for download from the Web.
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Changes to print settings are prioritized depending on where the changes are made:

The names of commands and dialog boxes might vary depending on your software program.

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and usually do not override changes made in the Page Setup dialog box.

Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box usually do not override
settings anywhere else in the printing software. You can change most of the print settings here.

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

Priority for print settings 11



Change printer-driver settings for Windows

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1.

On the File menu in the software
program, click Print.

Select the driver, and then click
Properties or Preferences.

The steps can vary; this procedure is
most common.

1.

Windows Vista and Windows 7:
Click Start, click Control Panel,
and then in the category for
Hardware and Sound click
Printer.

-0r-

Windows XP, Windows Server
2003, and Windows Server 2008
(using the default Start menu
view): Click Start, and then click
Printers and Faxes.

-0r-

Windows XP, Windows Server
2003, and Windows Server 2008
(using the Classic Start menu
view): Click Start, click Settings,
and then click Printers.

Right-click the driver icon, and then 2.

select Printing Preferences.

1.

Windows Vista and Windows 7:
Click Start, click Control Panel,
and then in the category for
Hardware and Sound click
Printer.

-0r-

Windows XP, Windows Server
2003, and Windows Server 2008
(using the default Start menu
view): Click Start, and then click
Printers and Faxes.

-0r-

Windows XP, Windows Server
2003, and Windows Server 2008
(using the Classic Start menu
view): Click Start, click Settings,
and then click Printers.

Right-click the driver icon, and then
select Properties.

Click the Device Settings tab.

12 Chapter 2 Software for Windows
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Remove software for Windows

Use the uninstall utility to remove Windows software
1. Click the Start button, and then click the Programs or All Programs menu item.

2. Click the HP menu item, and then click the HP LaserJet Professional P1100 Printer series menu
item.

3. Click the Uninstall menu item, and then follow the onscreen instructions to remove the software.

Use the Windows Control Panel to remove software

Windows XP, Windows Server 2003, and Windows Server 2008

1.  Click the Start button, click the Control Panel item, and then click the Add or Remove
Programs item.

2. Find and select the product from the list.

3. Click the Change/Remove button to remove the software.

Windows Vista and Windows 7

1. Click the Start button, click the Control Panel item, and then click the Programs and Features
item.

2. Find and select the product from the list.

3. Select the Uninstall/Change option.

ENWW Remove software for Windows 13



Supported utilities (wireless models only)
Embedded Web server

The product is equipped with an embedded Web server, which provides access to information about
product and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Apple Safari, or Firefox.

The embedded Web server resides on the product. It is not loaded on a network server.

The embedded Web server provides an interface to the product that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the product in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Print the information pages on page 46.)

For a complete explanation of the features and functionality of the embedded Web server, see
HP Embedded Web Server sections on page 47.
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3 Use the product with Mac
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° Print with Mac
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Software for Mac

Supported operating systems for Macintosh
The product supports the following Macintosh operating systems:

° Mac OS X v10.4, v10.5, and v10.6

Ef NOTE: PPC and Intel® Core™ processors are supported.

Supported printer drivers for Macintosh

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, a CUPS driver,
and the HP Printer Utilities for Mac OS X. The HP printer PPD file, in combination with the CUPS driver,
provides full printing functionality and access to specific HP printer features.

Remove software for Mac
Use the uninstall utility to remove the software.
1. Browse to the following folder:
Library/Printers/hp/laserjet/P1100 P1560 P1600Series/
2. Double-click the HP Uninstaller.app file.

3. Click the Continue button, and then follow the onscreen instructions to remove the software.

Priority for print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:

Bf NOTE: The names of commands and dialog boxes might vary depending on your software program.

e Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here might override settings changed
anywhere else.

e Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

o Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup or Print dialog boxes.
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Change printer-driver settings for Macintosh

ENWW

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1.

2.

On the File menu, click Print.

Change the settings that you want
on the various menus.

1.

2,

On the File menu, click Print.

Change the settings that you want
on the various menus.

On the Presets menu, click Save
as and type a name for the preset.

These settings are saved in the

Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print.

Mac OS X v10.4

1.

From the Apple menu, click System
Preferences and then Print &
Fax.

2. Click Printer Setup.

3. Click the Installable Options
menu.

Mac OS X v10.5 and v10.6

1. Fromthe Apple menu, click System
Preferences and then Print &
Fax.

2. Click Options & Supplies.

3. Click the Driver menu.

4.  Select the driver from the list, and

configure the installed options.
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Software for Mac computers

HP Printer Utility for Mac

Use the HP LaserJet Ultility to print the product information pages and to change the Auto-Off setting
from a Mac computer.

To open the HP LaserJet Utility, complete the procedure below.

A Open the Print Queue, and then click the Utility icon.

Supported utilities for Mac (wireless models only)

Embedded Web server

Network models are equipped with an embedded Web server, which provides access to information
about device and network activities. This information appears in a Web browser, such as Microsoft
Internet Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page.)
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Print with Mac

Create and use printing presets in Macintosh

Use printing presets to save the current printer driver settings for reuse.

Create a printing preset
1. On the File menu, click Print.
2. Select the driver.
3. Select the print settings.
4. Inthe Presets box, click Save As..., and type a name for the preset.

5. Click OK.

Use printing presets
1. On the File menu, click Print.
2. Select the driver.

3. Inthe Presets box, select the printing preset that you want to use.

Bf NOTE: To use printer-driver default settings, select Standard.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.
1. On the File menu, click Print.
2. Open the Paper Handling menu.

3. Inthe area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).
1. On the File menu, click Print.
2. Select the driver.

3.  Open the Cover Page menu, and then select whether to print the cover page Before Document
or After Document.

4. Inthe Cover Page Type menu, select the message that you want to print on the cover page.

Bf NOTE: To print a blank cover page, select Standard as the Cover Page Type.
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Print multiple pages on one sheet of paper in Macintosh

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1 2

11234

5.
6.

On the File menu, click Print.
Select the driver.
Open the Layout menu.

Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4,6,9, or 16).

Next to Layout Direction, select the order and placement of the pages on the sheet.

Next to Borders, select the type of border to print around each page on the sheet.

Print on both sides (duplex)

Print on both sides manually

1.

Insert enough paper into the input tray to accommodate the print job. If you are loading special
paper such as letterhead, load it face-down in the tray.

On the File menu, click Print.

Mac OS X v10.4: In the Layout drop-down list, select the Long-edged binding item or the Short-
edged binding item.

-or-
Mac OS X v10.5 and v10.6: Click the Two-sided check box.

Click Print. Follow the instructions in the dialog box that opens on the computer screen before
placing the output stack in the tray for printing the second half.

Go to the product, and remove any blank paper that is in the tray.

Take the printed stack from the output bin, and then insert the stack printed side down into the tray
with the top edge feeding into the product first.

At the computer, click the Continue button to finish the print job.
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4 Connect the product

e  Supported network operating systems (wireless models only)

° USB connection

° Network connection (wireless models only)

ENWW
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Supported network operating systems (wireless models

only)

The product supports the following operating systems for wireless printing:

Windows Vista (32-bit and 64-bit)
Windows XP (32-bit and 64-bit)
Windows 7

Windows Server 2003 (32-bit and 64-bit)
Windows Server 2008 (32-bit and 64-bit)
Mac OS X v10.4, v10.5, and v10.6
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This product supports a Hi-Speed USB 2.0 connection. You must use an A-to-B type USB cable that is
no longer than 2 m (6.56 ft).

B This installation type is supported for Windows only.

The HP Smart Install allows you to install the product driver and software by connecting the product to
a computer through a USB cable.

¢ The installation CD is not required during a HP Smart Install. Do not insert the software
installation CD into the computer CD drive.

Turn the product on.
Connect the USB cable.

The HP Smart Install program should start automatically. Follow the onscreen instructions to install
the software.

e If the HP Smart Install program does not start automatically, AutoPlay might be disabled on
the computer. Browse the computer and double-click the HP Smart Install drive to run the
program. If you cannot find the HP Smart Install drive, use the product installation CD to install
the software.

e If the program prompts you to select a connection type, select the connection type you will
use to print to the product after installation.

Insert the software installation CD into the computer CD drive.

/¢ Do not connect the USB cable until prompted.

If the installation program does not start automatically, browse the CD contents and run the
SETUP.EXE file.

Follow the onscreen instructions to install the software.
When you use the CD to install the software, you can choose the following types of installations:
Easy Install (recommended)

You will not be prompted to accept or make changes to default settings, and you automatically will
accept the software license agreement.

Advanced Install

You will be prompted to accept or make changes to default settings.
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Network connection (wireless models only)

The product can connect to wireless networks.

Supported network protocols

To connect a networking-equipped product to a network, you need a network that uses one of the
following protocols.

e TCP/IP (IPv4 or IPv6)

e Port9100
e LPR

e DHCP

e AutolP

e SNMP

e Bonjour
e SLP

e WSD

e NBNS

Install the product on a wireless network with HP Smart Install

Bf NOTE: This installation type is supported for Windows only.

The HP Smart Install allows you to install the product driver and software by connecting the product to
a computer through a USB cable. If the product previously has been installed on a network, reset the
wireless defaults. See Restore default wireless settings on page 27.

Ef NOTE: The installation CD is not required during a HP Smart Install. Do not insert the software
installation CD into the computer CD drive.

1. Turn on the product, and then connect the USB cable to the product and the computer. The
installation program should start automatically.
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e If the HP Smart Install program does not start automatically, AutoPlay might be disabled on
the computer. Browse the computer and double-click the HP Smart Install drive to run the
program. If you cannot find the HP Smart Install drive, use the product installation CD to install
the software.

e If the program prompts you to select a connection type, select the connection type you will
use to print to the product after installation.

Follow the onscreen instructions to complete the product installation.

When the installation is complete, if you want to verify that the product has a network IP address,
print a configuration page. Press and hold the product cancel X button until the ready Q) light blinks,
and then release the button to print the configuration page.

Install the product on a wireless network with the software CD

1.

Insert the software CD into the computer CD tray.

If the installation program does not start automatically, browse the CD contents and run the
SETUP.EXE file.

Follow the onscreen instructions to complete the product installation.

When the installation is complete, if you want to verify that the product has a network IP address,
print a configuration page. Press and hold the product cancel X button until the ready Q) light blinks,
and then release the button to print the configuration page.

Install the software for a product currently on the network

When the product previously has been installed on a network computer (so that it already has an IP
address), and you want to install the printer driver on another computer, complete the following steps.

1.

ENWW

At the computer, open the HP Embedded Web Server. See Open the HP Embedded Web Server
by using a network connection on page 47.

Click the HP Smart Install tab.
Click the Download button.

Follow the onscreen instructions to complete the product installation.
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Perform a peer-to-peer (ad-hoc) wireless installation
The product can be installed wirelessly to a computer through a peer-to-peer (ad-hoc) installation.
1. Turn on the product, and then restore the network setting.

2. Print a configuration page (see Configuration page on page 46), and find the network name
(SSID) in the Network Information section.

3. Refresh the computer wireless network connection list, and then click the product network name
(SSID) and connect to it.

4.  After several minutes, print a configuration page, and then find the product IP address.

5. Atthe computer, open a web browser, type the product IP address in the address box, and then
press the Enter key to open the HP Embedded Web Server.

6. Click the HP Smart Install tab, and then click the Download button to install the product software.

The figures below show the difference between an ad-hoc network connection and an infrastructure
network connection.

Ad-hoc network Infrastructure network

Turn off the product wireless unit

If you want to disconnect the product from a wireless network, you can turn off the wireless unit in the
product.

1. At the product control panel, press and hold the wireless button for more than 5 seconds.

2. To confirm that the wireless unit is turned off, print a configuration page, and then verify that the
product IP address is specified as 0.0.0.0 on the configuration page.
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Configure the network product

Use the Wireless Configuration utility
Use the Wireless Configuration utility to configure the product to print on a wireless network.
1. Connect the wireless product to the computer through a USB cable.
2. Click the Start button, and then click the Programs or All Programs menu item.

3. Click the HP menu item, and then click the HP LaserJet Professional P1100 Printer series menu
item.

4. Click the Wireless Configuration menu item.

5. Follow the onscreen instructions to configure the product to print on a wireless network.

Restore default wireless settings
1. Turn the product off.

2. Press and hold the wireless () button and the cancel X button, and then turn the product on.

3. Hold the buttons until all the lights blink in unison, and then release the buttons.

View or change network settings
Use the embedded Web server to view or change IP configuration settings.
1. Print a configuration page, and locate the IP address.
e If you are using IPv4, the IP address contains only digits. It has this format:
XXX . XXX XXX XXX

e If you are using IPv6, the IP address is a hexadecimal combination of characters and digits.
It has a format similar to this:

XXXX T I XXXX I XXXX I XXXX 1 XXXX
2. To open the embedded Web server, type the IP address into the address line of a Web browser.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the network password

Use the embedded Web server to set a network password or change an existing password.

1. Open the embedded Web server, click the Networking tab, and click the Password link.

Bf NOTE: Ifapassword has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

2. Type the new password in the Password box and in the Confirm Password box.

3. At the bottom of the window, click the Apply button to save the password.
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The product IP address can be set manually, or it can be configured automatically using DHCP, BootP,
or AutolP.

To change the IP address manually, use the HP Embedded Web Server.
Open the HP Embedded Web Server, and then click the Networking tab.
In the navigation pane, click the IPv4 Configuration link or the IPv6 Configuration link.
In the IP Address Configuration section, click the Manual IP option.

Type the required data in the Manual IP Address box, the IP Subnet Mask box, and the Manual
Default Gateway box.

Click the Apply button.

Use the Networking tab in the HP Embedded Web Server to set the link speed if necessary. The setting
is on the Advanced page.

Incorrect changes to the link speed setting might prevent the product from communicating with other
network devices. For most situations, leave the product in automatic mode. Changes can cause the
product to turn off, and then on. Only make changes when the product is idle.
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Paper and print media

° Understand paper and print media use

e  Special paper or print media guidelines

° Change the print driver to match the media type and size

° Supported paper sizes

e  Supported paper types and tray capacity

° Paper orientation for loading trays

e Load paper trays
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Understand paper and print media use

This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause poor print quality,
increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

A CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Special paper or print media guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver

to obtain the best results.

/A CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the

ENWW

product.
Media type Do Do not
Envelopes o  Store envelopes flat. o Do not use envelopes that are
wrinkled, nicked, stuck together, or
e  Use envelopes where the seam otherwise damaged.
extends all the way to the corner of
the envelope. ° Do not use envelopes that have
clasps, snaps, windows, or coated
e  Use peel-off adhesive strips that linings.
are approved for use in laser
printers. o Do not use self-stick adhesives or
other synthetic materials.
Labels e  Use only labels that have no o Donotuse labels that have wrinkles
exposed backing between them. or bubbles, or are damaged.
e  Use labels that lie flat. o Do not print partial sheets of labels.
e  Use only full sheets of labels.
Transparencies e Use only transparencies that are o Do not use transparent print media

approved for use in laser printers.

Place transparencies on a flat
surface after removing them from
the product.

not approved for laser printers.

Letterhead or preprinted forms

Use only letterhead or forms
approved for use in laser printers.

° Do not use raised or metallic
letterhead.

Heavy paper

Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

e Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper

Use only glossy or coated paper
that is approved for use in laser
printers.

o Do not use glossy or coated paper
designed for use in inkjet products.
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Change the print driver to match the media type and size

Selecting media by type and size results in significantly better print quality for heavy paper, glossy paper,
and overhead transparencies. Using the wrong setting can result in unsatisfactory print quality. Always
print by type for special print media, such as labels or transparencies. Always print by size for envelopes.

Ef NOTE: Depending on the software program, the commands and dialog box names that follow might
be different.

1. On the File menu in the software program, click the Print menu item.

2.  Select the driver, and then click the Properties button or the Preferences button.
3. Click the Paper/Quality tab.

4. Inthe Type is or Size is list box, select the correct media type or size.

5. Click the OK button.

32 Chapter 5 Paper and print media ENWW



Supported paper sizes

This product supports various paper sizes, and it adapts to various media.

Bf NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before

ENWW

printing.

Table 5-1 Supported paper and print media sizes

Size Dimensions Input tray Priority input slot
(wireless models
only)

Letter 216 x 279 mm (8.5 x 11 in) \/ \/

Legal 216 x 356 mm (8.5 x 14 in) \/ \/

Ad 210 x 297 mm (8.27 x 11.69 in) / /

Executive 184 x 267 mm (7.25 x 10.5 in) / /

A5 148 x 210 mm (5.83 x 8.27 in) / /

A6 105 x 148 mm (4.13 x 5.83 in) / /

B5 (ISO) 176 x 250 mm (6.93 x 9.84 in) v v

B5 (JIS) 182 x 257 mm (7.17 x 10.12 in) v v

16k 184 x 260 mm (7.24 x 10.23 in)

195 x 270 mm (7.68 x 10.62 in) v v
197 x 273 mm (7.75 x 10.75 in)
Custom Minimum: 76 x 127 mm (3 x 5 in) \/ \/
Maximum: 216 x 356 mm (8.5 x 14.0 in)
Table 5-2 Supported envelopes and postcards

Size Dimensions Input tray Priority input slot
(wireless models
only)

Envelope #10 105 x 241 mm (4.13 x 9.49 in) \/ \/

Envelope DL 110 x 220 mm (4.33 x 8.66 in) ‘/ ‘/

Envelope C5 162 x 229 mm (6.93 x 9.84 in) ‘/ ‘/

Envelope B5 176 x 250 mm (6.7 x 9.8 in) ‘/ ‘/

Envelope Monarch 98 x 191 mm (3.9 x 7.5 in) \/ \/

Double postcard 148 x 200 mm (5.83 x 7.87 in) \/ \/

(JIs)

Supported paper sizes
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Supported paper types and tray capacity

Supported paper and print media types

For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/

ljp1100series.

Paper type (printer driver) Input tray

Priority input slot (wireless models only)

Paper, including the following types: ‘/
e Plain
o Vellum

o Recycled

v

Rough

Envelope

Labels

Cardstock

Transparency

ANIANANANE NN

Postcards

ANIANA NANE NN

Tray and bin capacity

Tray or bin Paper type Specifications Quantity
Input tray Paper Range: 150 sheets of 75 g/m? (20 Ib)
bond
60 g/m? (16 Ib) bond to 163 g/m?
(43 Ib) bond
Envelopes 60 g/m? (16 Ib) bond to 90 g/m?  Up to 10 envelopes
(24 Ib) bond
Transparencies Minimum 0.13 mm (0.005 in) Up to 75 transparencies
thick
Output bin Paper Range: Up to 125 sheets of 75 g/m?
(20 Ib) bond
60 g/m? (16 Ib) bond to 163 g/m?
(43 Ib) bond
Envelopes Less than 60 g/m? (16 Ib) bond to  Up to 10 envelopes
90 g/m? (24 Ib) bond
Transparencies Minimum 0.13 mm (0.005 in) Up to 75 transparencies

thick
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Paper orientation for loading trays

If you are using paper that requires a specific orientation, load it according to the information in the
following table.

Paper type How to load paper

Preprinted or letterhead e Faceup

e  Top edge leading into the product

Prepunched e Faceup

o Holes toward the left side of the product

Envelope e Faceup

e  Left short edge leading into the product

Load paper trays

A CAUTION: If you try to print on media that is wrinkled, folded, or damaged in any way, a jam might
occur. See Clear jams on page 73 for more information.

Priority feed slot

The priority feed slot holds up to 10 sheets of media or one envelope, one transparency, or one sheet
of labels or cardstock. Load media with the top forward and the side to be printed on facing up. To
prevent jams and skewing, always adjust the side media guides before feeding the media.

Input tray

The input tray holds 150 pages of 75 g/m? (20 Ib) paper, or fewer sheets of heavier media (a 15 mm
(0.6 in) stack height or less).

Load media with the top forward and the side to be printed on facing up. To prevent jams and skewing,
always adjust the side and front media guides.

B NOTE: When you add new media, make sure that you remove all of the media from the input tray and
straighten the entire stack. This helps prevent multiple sheets of media from feeding through the product
at one time, reducing media jams.
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Tray adjustment for short media (base models only)
To print on media shorter than 185 mm (7.28 in), use the short media extender to adjust your input tray.

1. Remove the short media extender tool from the storage slot on the left side of the media input area.

2. Attach the tool to the adjustable media guide.

3. Insert the media into the product until it stops, and then slide the adjustable media guide, with the
tool attached to support the media.

4. When finished printing with short media, remove the short media extender tool, and then place it
back in the storage slot.
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6 Print tasks

e Cancel a print job

° Print with Windows

ENWW
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Cancel a print job

You can stop a print job by using the software program.

Bf NOTE: It can take several minutes for all print jobs to clear after you have canceled a print job.

Stop the current print job from the control panel (wireless models only)

A Press the cancel X button on the control panel.

Stop the current print job from the software program

When you send the print job, a dialog box opens briefly on the screen, giving you the option to cancel
the print job.

If several jobs are sent to the product through your software, they might be waiting in a print queue (for
example, in Windows Print Manager). See the software program documentation for specific instructions
about canceling a print job from the computer.

If a print job is waiting in a print queue or print spooler, delete the print job there.

1. Windows Vista and Windows 7: Click Start, click Control Panel, and then in the category for
Hardware and Sound click Printer.

-or-

Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu
view): Click Start, click Settings, and then click Printers and Faxes.

-or-

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu
view): Click Start, click Settings, and then click Printers.

2. Inthe list of printers, double-click the name of this product to open the print queue or spooler.

3. Select the print job that you want to cancel, right-click the job, and then click the Cancel or
Delete item.
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Print with Windows

Bf NOTE: Depending on the software program, the commands and dialog box names that follow might
be different.

Open the Windows printer driver

1.
2.

On the File menu in the software program, click Print.

Select the product, and then click Properties or Preferences.

Get help for any print option with Windows

Printer-driver Help is separate from program Help. The printer-driver help provides explanations for the
buttons, check boxes, and drop-down lists that are in the printer driver. It also includes instructions for
performing common printing tasks, such as printing on both sides, printing multiple pages on one sheet,
and printing the first page or covers on different paper.

Activate the printer-driver Help screens in one of the following ways:

In the printer driver Properties dialog box, click the Help button.
Press the F1 key on the computer keyboard.
Click the question-mark symbol in the upper-right corner of the printer driver.

Right-click on any item in the driver.

Change the number of print copies with Windows

1.

Open the printer driver, click the Properties or Preferences button, and then click the
Advanced tab.

In the Copies area, use the arrow buttons to adjust the number of copies.
If you are printing multiple copies, click the Collate check box to collate the copies.

Click the OK button.

Print colored text as black with Windows

1.

2.
3.

Open the printer driver, click the Properties or Preferences button, and then click the
Advanced tab.

Click the Print All Text as Black check box.
Click the OK button.

Save custom print settings for reuse with Windows

Use a printing quick set

1.

ENWW

Open the printer driver, and then click the Properties or Preferences button. The Print Tasks
Quick Sets drop-down list appears on all tabs except the Services tab.

In the Print Tasks Quick Sets drop-down list , select one of the quick sets, and then click OK to
print the job with the predefined settings.
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Create a custom printing quick set

1. Open the printer driver, and then click the Properties or Preferences button. The Print Tasks
Quick Sets drop-down list appears on all tabs except the Services tab.

2. Select an existing quick set as a base.
3.  Select the print options for the new quick set.

4. Click Save As, type a name for the quick set, and then click OK.

Improve print quality with Windows

Select a page size

1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/
Quality tab.

2. Select a size from the Size is drop-down list.

3. Click the OK button.

Select a custom page size
1. Open the printer driver, and then click the Paper/Quality tab.
2.  Click the Custom button. The Custom Paper Size dialog box opens.
3. Type a name for the custom size, specify the dimensions, and then click Save.

4.  Click the Close button, and then click the OK button.

Select a paper type

1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/
Quality tab.

2. Select a type from the Type is drop-down list.
3. Click the OK button.

Select the print resolution

1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/
Quality tab.

2. Inthe Print Quality area, select an option from the drop-down list. See the printer-driver online
Help for information about each of the available options.

B NOTE: To use a draft-quality resolution, in the Print Quality area, click the EconoMode check
box.

3. Click the OK button.
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Print the first or last page on different paper with Windows

1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/
Quality tab.

2.  Click the Use Different Paper/Covers check box, and then select the necessary settings for the
front cover, other pages, and back cover.

3. Click the OK button.

Scale a document to fit page size with Windows
1. Open the printer driver, click the Properties or Preferences button, and then click the Effects tab.
2. Click the Print document on check box, and then select a size from the drop-down list.

3. Click the OK button.

Add a watermark to a document with Windows
1. Open the printer driver, click the Properties or Preferences button, and then click the Effects tab.
2. Select a watermark from the Watermarks drop-down list.

To print the watermark on the first page only, click the First page only check box. Otherwise, the
watermark is printed on each page.

3. Click the OK button.

Print on both sides (duplex) with Windows

Manually print on both sides (duplex)

1. Load paper face-up in the input tray.

2. Open the printer driver, and then click the Properties or Preferences button.
3. Click the Finishing tab.

4. Click the Print On Both Sides (manually) check box. If you will bind the document along the top
edge, click the Flip pages up check box.

5. Click the OK button to print the first side of the job.
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6. Retrieve the printed stack from the output bin, and, maintaining the paper orientation, place it with
the printed-side facing down in the input tray.

7.  Atthe computer, click the Continue button to print the second side of the job.

Create a booklet with Windows

1. Open the printer driver, click the Properties or Preferences button, and then click the Finishing
tab.

2. Click the Print on both sides (manually) check box.

3. Inthe Booklet layout drop-down list, click the Left binding or Right binding option. The Pages
per sheet option automatically changes to 2 pages per sheet.

4.  Click the OK button.
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Print multiple pages per sheet with Windows

1. Open the printer driver, click the Properties or Preferences button, and then click the Finishing
tab.

2. Select the number of pages per sheet from the Pages per sheet drop-down list.
3. Select the correct options for Print Page Borders, Page Order, and Orientation.

4. Click the OK button.

Select page orientation with Windows

1. Open the printer driver, click the Properties or Preferences button, and then click the Finishing
tab.

2. Inthe Orientation area, select the Portrait or Landscape option.
To print the page image upside down, select the Rotate by 180 degrees option.

3. Click the OK button.
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Manage and maintain the product

° Print the information pages

° Use the HP Embedded Web Server (wireless models only)

° Economy settings

° Manage supplies and accessories

° Clean the product

° Product updates
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Print the information pages

You can print the following information pages.

Configuration page

The configuration page lists current product settings and properties. It also contains a status log report.
To print a configuration page, do the following:

1. Open the printer driver, and then click the Properties or Preferences button.

2. Click the Services tab, and then, in the Print Information Pages drop-down list, click the Config
Page list item.

3. Click the Print button.
On wireless models, you can print the configuration page from the product control panel.

A Atthe control panel, press and hold the cancel X button until the ready Q) light starts blinking, and
then release the button.

Supplies status page

To print the supplies status page, select it from the Print Information Pages drop-down on the
Services tab in the printer driver. The supplies status page provides the following information:

e The estimated percentage of toner remaining in the print cartridge
e The number of pages and print jobs that have been processed
e  Ordering and recycling information
Demo page
To print the demo page, select it from the Print Information Pages drop-down on the Services tab in

the printer driver. The demo page contains examples of text and graphics, and is used to show product
print quality.
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Use the HP Embedded Web Server (wireless models only)

Use the HP Embedded Web Server (EWS) to view product and network status and to manage printing
functions from a computer.

View product status information
Determine the remaining life on all supplies and order new ones
View and change the product default configuration settings

View and change network configuration

You do not need to install any software on the computer. You only need to use one of these supported
Web browsers:

Internet Explorer 6.0 (and later)
Firefox 1.0 (and later)

Mozilla 1.6 (and later)

Opera 7.0 (and later)

Safari 1.2 (and later)

Konqueror 3.2 (and later)

The HP Embedded Web Server works when the product is connected to a TCP/IP-based network. The
HP Embedded Web Server does not support IPX-based connections or direct USB connections.

NOTE: You do not have to have Internet access to open and use the HP Embedded Web Server.
However, if you click a link on any of the pages, you must have Internet access to go to the site
associated with the link.

Open the HP Embedded Web Server by using a network connection

To open the HP Embedded Web Server, type the IP address or host name of the product in the address
field of a supported Web browser. To find the IP address, print a configuration page at the product by
pressing and holding the cancel X button when the ready Q light is on and no other jobs are printing.
Hold the button until the ready Q) light starts blinking.

X TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

HP Embedded Web Server sections

Information tab

ENWW

The Information pages group consists of the following pages:

Device Status displays the status of the product and HP supplies.
Device Configuration shows the information found on the Configuration page.

Supplies Status shows the status of HP supplies and provides part numbers. To order new
supplies, click Order Supplies in the upper-right part of the window.

Network Summary shows the information found on the Network Summary page.
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Use this tab to configure the product from your computer. If this product is networked, always consult
with the product administrator before changing settings on this tab.

The Settings tab contains the Printing page where you can view and change the default print job
settings.

Network administrators can use this tab to control network-related settings for the product when it is
connected to an IP-based network.

& This tab is supported for Windows only.

Use this tab to install the product driver and software on a computer. Click the Download button to start
the installation process, and then follow the onscreen instructions to finish the process.

Links are located in the upper-right part of the status pages. You must have Internet access to use any
of these links. If you use a dial-up connection and did not connect when you first opened the

HP Embedded Web Server, you must connect before you can visit these Web sites. Connecting might
require that you close the HP Embedded Web Server and reopen it.

Shop for Supplies. Click this link to connect to the Sure Supply Web site and order genuine
HP supplies from HP or a reseller of your choice.

Support. Connects to the product support site. You can search for help regarding general
topics.
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Economy settings
Auto-Off mode

Auto-Off is an energy-saving feature of this product. After a user-specified time period, the product
automatically reduces its power consumption (Auto-Off). The product returns to the ready state when a
button is pressed or a print job is received. When the product is in Auto-Off mode, all of the control-panel
LEDs and the power button backlight LED are off.

Bf NOTE: Although the product lights are off in Auto-Off mode, the product will work normally when it
receives a print job.

Change the Auto-Off delay time

You can change how long the product remains idle (Auto-Off delay) before it enters Auto-Off mode.

Bf NOTE: The default Auto-Off delay setting is 5 minutes.

1. Open the printer properties, and then click the Device Settings tab.

2. Select the Auto-Off delay from the Auto-Off drop-down list.

Bf NOTE: The changed setting does not go into effect until a print job is sent to product.

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use
less toner and decrease the cost per page. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade under
these circumstances, you must install a new print cartridge, even if there is toner supply remaining in
the cartridge.

Enable EconoMode with Windows
1. Open the printer driver, and then click the Properties or Preferences button.
2. Click the Paper/Quality tab.
3. Click the EconoMode check box.

ENWW Economy settings 49



Manage supplies and accessories

Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Check and order supplies

Print-cartridge storage

Do not remove the print cartridge from its package until you are ready to use it.

/\ CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

Bf NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

To install a new genuine HP print cartridge, see Replace the print cartridge on page 52.

HP fraud hotline and Web site

Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the control-panel message says the cartridge
is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:
e You are experiencing a high number of problems with the print cartridge.

e The cartridge does not look like it usually does (for example, the orange pull tab is missing, or the
packaging differs from HP packaging).

Recycle supplies

To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.
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Replacement instructions

Redistribute toner

When a small amount of toner remains in print cartridge, faded or light areas might appear on the printed
page. You might be able to temporarily improve print quality by redistributing the toner.

1. Open the print-cartridge door, and then remove the print cartridge.

2. Toredistribute the toner, gently rock the print cartridge from front to back.

/A CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing in cold
water. Hot water sets toner into the fabric.
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3. Reinsert the print cartridge into the product, and then close the print-cartridge door.

If the print is still light, install a new print cartridge.

Replace the print cartridge

When a print cartridge approaches the end of useful life, you can continue printing with the current
cartridge until redistributing the toner no longer yields acceptable print quality.

1. Open the print-cartridge door, and then remove the old print cartridge.
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2.  Remove the new print cartridge from the packaging. Place the used print cartridge in the bag and
box for recycling.

/A CAUTION: To prevent damage to the print cartridge, hold the print cartridge at each end. Do not
touch the cartridge shutter or the roller surface.

3.  Grasp both sides of the print cartridge and gently rock the print cartridge to distribute the toner
evenly inside the cartridge.
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4. Bend the tab on the left side of the cartridge until the tab breaks loose, and then pull the tab until
all the tape is removed from the cartridge. Place the tab and tape in the print-cartridge box to return
for recycling.

5. Insert the print cartridge in the product, and then close the print-cartridge door.

/A CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing in cold
water. Hot water sets toner into the fabric.
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Replace the pickup roller

Normal use with good media causes wear. The use of poor media might require more frequent
replacement of the pickup roller.

If the product regularly mispicks (no media feeds through), you might need to change or clean the pickup
roller. See Clean the pickup roller on page 61 to order a new pickup roller.

1. Open the print-cartridge door, and then remove the print cartridge.

/A CAUTION: To prevent damage to the print cartridge, minimize its exposure to direct light. Cover
the print cartridge with a sheet of paper.

2. Find the pickup roller.
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3. Release the small, white tabs on each side of the pickup roller, and rotate the pickup roller toward
the front.

4.  Gently pull the pickup roller up and out.

5. Position the new pickup roller in the slot. The circular and rectangular slots on each side prevents
you from installing the roller incorrectly.

g
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6. Rotate the top of the new pickup roller away from you until both sides snap into place.

=

7. Insert the print cartridge in the product, and then close the print-cartridge door.
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Replace the separation pad

Normal use with good media causes wear. The use of poor media might require more frequent
replacement of the separation pad.

If the product regularly pulls multiple sheets of media at a time, you might need to change the separation
pad.

Bf NOTE: Before you change the separation pad, clean the pickup roller. See Clean the pickup roller
on page 61.

A WARNING! Before changing the separation pad, turn the product off, disconnect the power cord from
the wall outlet, and then wait for the product to cool.

1. Disconnect the product power cord from the product.
2. Remove the paper and close the input tray. Set the product on its front.

3.  Atthe bottom of the product, unscrew the two screws holding the separation pad in place.
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4.  Remove the separation pad.

5. Insert the new separation pad, and screw it into place.
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6. Reconnect the power cord, and then turn on the product.
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Clean the product

Clean the pickup roller
If you want to clean the pickup roller before deciding to replace it, follow these instructions:

1. Unplug the power cord from the product and remove the pickup roller as described in Replace the
pickup roller on page 55.

2. Dab a lint-free cloth in isopropyl alcohol, and scrub the roller.

i)

/A WARNING! Alcohol is flammable. Keep the alcohol and cloth away from an open flame. Before
you close the product and plug in the power cord, allow the alcohol to dry completely.

Bf NOTE: In certain areas of California, air pollution control regulations restrict the use of liquid
Isopropyl Alcohol (IPA) as a cleaning agent. In those areas of California, please disregard the
previous recommendations and use a dry, lint-free cloth, moistened with water, to clean the pickup
roller.

3. Using a dry, lint-free cloth, wipe the pickup roller to remove loosened dirt.

1

4. Allow the pickup roller to dry completely before you reinstall it in the product.

e

5. Reconnect the power cord.
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Clean the paper path

If you are experiencing toner specks or dots on the printouts, clean the paper path. This process uses
a transparency to remove dust and toner from the paper path. Do not use bond or rough paper.

' AGBbCc
AaBbCc,
AaBbCc
AcBBCC.

Ef NOTE: For best results use a sheet of transparency. If you do not have any transparencies, you can
use copier-grade media (60 to 163 g/m? (16 to 43 Ib)) that has a smooth surface.

—

Make sure that the product is idle and the ready light Q is on.
2. Load media in the input tray.

3. Open the printer Properties.

4. Click the Device Settings tab.

5. Inthe Cleaning Page area, click the Start button to process the cleaning page.

Ef NOTE: The cleaning process takes about 2 minutes. The cleaning page stops periodically during the
cleaning process. Do not turn the product off until the cleaning process has finished. You might need to
repeat the cleaning process several times to thoroughly clean the product.
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Clean the print-cartridge area

You do not need to clean the print-cartridge area often. However, cleaning this area can improve the
quality of the printed sheets.

/A WARNING! Before changing the separation pad, turn the product off, disconnect the power cord from
the wall outlet, and then wait for the product to cool.

1. Disconnect the power cord from the product. Open the print-cartridge door, and then remove the
print cartridge.

/A CAUTION: Do not touch the black-sponge transfer roller inside the product. Doing so can
damage the product.

CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a piece
of paper.
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2. With adry, lint-free cloth, wipe any residue from the paper-path area and the print-cartridge cavity.

3. Reinstall the print cartridge, and then close the print-cartridge door.
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4. Disconnect the power cord.

Clean the exterior

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the device.

Product updates

Software and firmware updates and installation instructions for this product are available at
www.hp.com/support/lip1100series. Click Downloads and drivers, click the operating system, and
then select the download for the product.
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Solve problems

e Solve general problems

° Interpret control-panel light patterns

° Clear jams

e Solve paper-handling problems

e Solve image-quality problems

e Solve performance problems

e Solve connectivity problems

e Solve product software problems
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If the product is not responding correctly, complete the steps in the following checklist, in order. If the
product does not pass a step, follow the corresponding troubleshooting suggestions. If a step resolves
the problem, you can stop without performing the other steps on the checklist.

Make sure that the product is set up correctly.
a. Press the power button to turn on the product or to deactivate the Auto-Off mode.
b. Check the power-cable connections.

c. Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip and
its voltage is not within specifications, plug the product directly into the wall. If it is already
plugged into the wall, try a different outlet.

d. Make sure that the print cartridge is installed correcitly.
e. If none of these measures restores power, contact HP Customer Care.
Check the cabling or wireless connection (wireless models only).

a. Check the cable connection between the product and the computer. Make sure that the
connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.
c. For a wireless connection, look at the control panel wireless light.
If the light is on, the product has a connection with a network.

If the light is blinking, the product is searching for a network connection. Make sure that
the wireless router or access point and the product are set to use the same mode or
protocol.

If the light is off, the product is not connected to the network and the wireless unit in the
product might be off. Press the wireless button to try connecting to the network, or run
the Wireless Configuration utility to configure the product. See

. To verify that the product finds the network, print a
configuration page. The product should have an IP address assigned to it.

If the product remains unable to connect to the network, uninstall and then reinstall the
product. If the error persists, contact a network administrator or refer to the user manual of
the wireless router or access point.

Check to see if any control-panel lights are lit. See

Make sure that the paper that you are using meets specifications.
Make sure that the paper is loaded correctly in the input tray.
Make sure that the product software is installed correctly.

Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product.
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Print a configuration page. See Print the information pages on page 46.

a. If the page does not print, verify that the input tray contains paper.

b. If the page jams in the product, see Clear jams on page 73.

Print a small document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print), complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. Check the USB cable connection. Direct the product to the correct port, or reinstall the
software, selecting the connection type that you are using.

c. If the print quality is unacceptable, complete the following steps:

e Verify that the print settings are correct for the media that you are using. See Change
the print driver to match the media type and size on page 32.

e Use the procedures in Solve image-quality problems on page 82 to solve print-quality
problems.

Factors that affect product performance

ENWW

Several factors affect the time it takes to print a job:

The use of special paper (such as transparencies, heavy paper, and custom-size paper)
Product processing and download time

The complexity and size of graphics

The speed of the computer you are using

The USB or network connection

The product I/O configuration
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Interpret control-panel light patterns

Table 8-1 Status-light legend

() Symbol for "light off"
@) Symbol for "light on"
U Symbol for "light blinking"
—Q-
/ I

Table 8-2 Control-panel light patterns

Light status State of the product Action
All lights are off. The product is in Auto-Off mode or is Press the power button to deactivate the
turned off. Auto-Off mode or to turn on the product.

Status lights cycle The status lights cycle during the No action is required. Wait for the

formatter initialization period or when the initialization period to end. The product

product is processing a cleaning page. should enter the ready state when the
initialization period is finished.

Ready light is on, and attention lightis  The product is in the ready state. No action is required. The product is
off. ready to receive a print job.
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Table 8-2 Control-panel light patterns (continued)

Action

Light status State of the product
Ready light is blinking, and attention The product is receiving or processing
light is off. data.

Sl

No action is required. The product is
receiving or processing a print job.

Attention light is blinking, and ready
light is off.

The product has experienced an error that
can be corrected at the product, such as
a jam, an open door, the absence of a
print cartridge, or the absence of paper in
the proper tray.

A

o]
—Z1

Inspect the product, determine the error,
and then correct the error. If the error is
the absence of paper in the proper tray or
the product is in a manual feed mode, put
the proper paper in the tray and follow the
onscreen instructions, or open and close
the print-cartridge door to resume
printing.

Attention light is blinking, and ready
light is on.

The product has experienced a continual
error from which it will recover on its own.

S\

o]
—Z|

If the recovery is successful, the product
continues to the processing data state
and completes the job.

If the recovery is unsuccessful, the
product continues to the continuable
error state. Try removing any media from
the media path and turning the product
power off, and then on again.

The attention and ready lights are on.  The product has experienced a fatal error

from which it cannot recover.

1. Turn off the product or disconnect
the power cord from the product.

2. Wait 30 seconds, and then turn on
the product or reconnect the power
cord to the product.

3. Wait for the product to initialize.

If the error persists, contact HP customer
support. See Customer support
on page 102.
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Table 8-2 Control-panel light patterns (continued)

Light status

State of the product

Action

The wireless light is blinking.

The product is attempting to locate a
wireless network.

No action is required.

The wireless light is on.

The product is connected to a wireless

No action is required.

The wireless light is off.

The product is not connected to a
network, and the wireless unit in the
product might be turned off.

If the light is off, the product is not
connected to the network and the
wireless unit in the product might be off.
Press the wireless button to try
connecting to the network, or run the
Wireless Configuration utility to configure
the product. See Use the Wireless
Configuration utility on page 27. To verify
that the product finds the network, print a
configuration page. The product should
have an IP address assigned to it.

For information about connecting
wirelessly to a network, see Network
connection (wireless models only)

on page 24.

If the product remains unable to connect
to the network, uninstall and then reinstall
the product. If the error persists, contact
a network administrator or refer to the
user manual of the wireless router or
access point.
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Clear jams

When clearing jams, be careful not to tear jammed paper. If a small piece of paper remains in the product,
it could cause additional jams.

Common causes of jams

e The inputtray is loaded incorrectly or is too full.

B NOTE: When you add new media, always remove all of the media from the input tray and
straighten the entire stack. This helps prevent multiple feeds and reduces media jams.

e The media does not meet HP specifications.

e The product might need to be cleaned to remove paper dust and other particles from the paper
path.

Loose toner might remain in the product after a media jam. This toner clears up after a few sheets print.

/A CAUTION: If you get any toner on your clothes, wash them in cold water. Hot water will permanently
set the toner into the fabric.
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Jam locations

Jams can occur at the following locations in the product.

1 Internal areas
2 Input tray
3 Qutput bin

B NOTE: Jams can occur in more than one location.

Clear jams from the input tray

/A CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.

74 Chapter 8 Solve problems ENWW



B NOTE: Depending on where the jam is located, some of the following steps might not be necessary.

1. Open the print-cartridge door, and then remove the print cartridge.

2. Remove the media stack from the input tray.
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3. With both hands, grasp the side of the jammed media that is most visible (this includes the middle),
and carefully pull it free from the product.

4. Reinstall the print cartridge, and then close the print-cartridge door.
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Clear jams from the output areas

/A CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

1. Open the print-cartridge door, and then remove the print cartridge.

2. Keep the print cartridge door open, and then with both hands, grasp the side of the jammed media
that is most visible (this includes the middle), and carefully pull it free from the product.
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3. Reinstall the print cartridge, and then close the print-cartridge door.
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Clear jams from inside the product

1. Open the print-cartridge door, and then remove the print cartridge.

/A CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a piece
of paper.

2. If you can see the jammed paper, carefully grasp the jammed paper, and slowly pull it out of the
product.
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3. Reinstall the print cartridge, and then close the print-cartridge door.

Solve repeated jams

e Verify that the input tray is not overfilled. The input tray capacity varies depending on the type of
print media that you are using.

e  Verify that the media guides are properly adjusted.

e Check that the input tray is securely in place.

e Do not add print media into the input tray while the product is printing.
e Use only HP-recommended media types and sizes.

e Do not fan media prior to loading it in a tray. To loosen the ream, hold it firmly in both hands and
twist the media by rotating your hands in the opposite direction.

e Do not let print media stack up in the output bin. The print media type and the amount of toner used
affect the output bin capacity.

e  Check the power connection. Make sure that the power cord is firmly connected to both the product
and the power supply box. Plug the power cord into a grounded power outlet.

Change the jam recovery setting

When the Jam Recovery feature is turned on, the product reprints any pages that are damaged during
ajam.

1. Open the product Properties dialog box.
2. Click the Device Settings tab.

3. Click the Auto option or the Off option under Jam Recovery.
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Solve paper-handling problems

The following problems with media cause print-quality deviations, jamming, or damage to the product.

Problem

Cause

Solution

Poor print quality or toner adhesion

The paper is too moist, too rough, too
heavy or too smooth, or it is embossed
or from a faulty paper lot.

Try another kind of paper, between 100
and 250 Sheffield, with 4% to 6%
moisture content.

Dropouts, jamming, or curl

The paper has been stored incorrectly.

Store paper flat in its moisture-proof
wrapping.

The paper has variability from one side
to the other.

Turn the paper over.

Excessive curl

The paper is too moist, has the wrong
grain direction, or is of short-grain
construction

Use long-grain paper.

The paper varies from side-to-side.

Turn the paper over.

Jamming, damage to product

The paper has cutouts or perforations.

Use paper that is free of cutouts or
perforations.

Problems with feeding

The paper has ragged edges.

Use high-quality paper that is made for
laser printers.

The paper varies from side-to-side.

Turn the paper over.

The paper is too moist, too rough, too
heavy or too smooth, has the wrong grain
direction, or is of short-grain construction
or it is embossed or from a faulty paper
lot.

Try another kind of paper, between 100
and 250 Sheffield, 4% to 6% moisture
content.

Use long-grain paper.

Print is skewed (crooked).

The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the
media in the input tray again. Adjust the
media guides to the width and length of
the media that you are using and try
printing again.

More than one sheet feeds at one time.

The media tray might be overloaded.

Remove some of the media from the tray.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled,
folded, or damaged. Try printing on
media from a new or different package.

The product does not pull media from the
input tray.

The product might be in manual-feed
mode.

At the computer, follow the onscreen
instructions to deactivate manual-feed
mode. Or, at the product, open and close
the print-cartridge door.

The pickup roller might be dirty or
damaged.

Contact HP Customer Care. See Service
and support on page 97 or the support
flyer that came in the box.

The paper-length adjustment control in
the input tray is set at a length that is
greater than the media size.

Set the paper-length adjustment control
to the correct length.

Solve paper-handling problems
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Solve image-quality problems

You can prevent most print-quality problems by following these guidelines.

e Use paper that meets HP specifications. See Paper and print media on page 29.

e  Clean the product as necessary. See Clean the product on page 61.

Image defect examples

This section provides information about identifying and correcting print defects.

Ef NOTE: If these steps do not correct the problem, contact an HP-authorized dealer or service
representative.

Light print or faded

o Redistribute the toner to extend the life. See Redistribute

Aa Cc toner on page 51.
Aa Cc e  The print cartridge is nearing end of life. Install a new
genuine HP print cartridge.
Aa Cc o .
e  The media might not meet Hewlett-Packard's media
Aa Cc specifications (for example, the media is too moist or too
rough).
Aa ' Cc

o If the whole page is light, the print density adjustment is
too light or EconoMode might be turned on. Adjust the
print density, and disable EconoMode in the product
Properties.

Toner specks

e  The media might not meet Hewlett-Packard's media

, AO BbCC specifications (for example, the media is too moist or too
AT rough).
AQBbCC e  The product might need to be cleaned.
‘AcBobCc, o .
T e e The print cartridge might be defective. Install a new
A@ BbCC genuine HP print cartridge.
AaBBCC.
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Dropouts

AQBbCc
AaBRbCc
AcBCCc
AcBLCC
AaBbCc

A single sheet of media might be defective. Try reprinting
the job.

The media moisture content is uneven or the media has
moist spots on its surface. Try printing with new media.

The media lot is bad. The manufacturing processes can
cause some areas to reject toner. Try a different type or
brand of media.

The print cartridge might be defective. Install a new
genuine HP print cartridge.

Vertical lines

AQBbCC
AQBLCC
AQBLCC
AaBbCg
AaBbCg

Toner might be on the photosensitive drum. Print a few
more pages to see if the problem might correct itself.

The photosensitive drum inside the print cartridge has
probably been scratched. Install a new genuine HP print
cartridge.

Gray background

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

Change the media to a lighter basis weight.

Check the product environment. Very dry (low humidity)
conditions can increase the amount of background
shading.

The density setting might be too high. Adjust the density
setting. See Change print density on page 86

Install a new genuine HP print cartridge.

Toner smear

AaBbCc
AoBbc
AaBhCc
AaBCc
AaBbCc

If toner smears appear on the leading edge of the media,
the media guides might be dirty. Wipe the media guides
with a dry, lint-free cloth.

Check the media type and quality.

The fuser temperature might be too low. In the printer
driver, make sure the appropriate media type is selected.

Try installing a new genuine HP print cartridge.
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Loose toner

e  The fuser temperature might be too low. In the printer

AO B P;\/‘C driver, make sure the appropriate media type is selected.
/“q BbCC e Clean the inside of the product. See Clean the product
on page 61.

AaBbCc

AaBbCc o . .
e  Plug the product directly into an AC outlet instead of into

AO BbCC a power strip.

o  Check the media quality.

Vertical repetitive defects

- e  The print cartridge might be damaged. If a repetitive mark
AQ Bbce occurs at the same spot on the page, install a new

genuine HP print cartridge.
AaBCc . .
’— e  Theinternal parts might have toner on them. If the defects
> occur on the back of the page, the problem probably will
(>
correct itself after a few more printed pages.
AaBbCc_
e In the printer driver, make sure the appropriate media

ACI B bCé type is selected.

Misformed characters

° If characters are improperly formed, producing hollow
AaBbCc images, the media stock might be too slick. Try a different
AaBbCo media.
AaBlbCc e If characters are improperly formed, producing a wavy
AaBbCc effect, the product might need service. Print a

configuration page. If the characters are improperly
AacBbCc formed, contact an HP-authorized dealer or service
AaBbCc representative.
Page skew

e  Make sure that the media is loaded correctly and the
AG BbCC media guides are not too tight or too loose against the

AG BbCC media stack.
AABbCc
AQBbCc
AaBbCc

e  The input bin might be too full.

o  Check the media type and quality.
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Curl or wave

e~ —

AgBpC%
AQBHLC¢
AQBObCC
AQBbC¢
AaBpbC¢
~ N ]

Check the media type and quality. Both high temperature
and high humidity cause media to curl.

The media might have been in the input tray too long.
Turn over the stack of media in the tray. Also, try rotating
the media 180° in the input tray.

The fuser temperature might be too high. In the printer
driver, make sure that the appropriate media type is
selected. If the problem persists, select a media type that
uses a lower fuser temperature, such as transparencies
or light media.

Wrinkles or creases

AaBbCc

Make sure that media is loaded properly.
Check the media type and quality.

Turn over the stack of media in the tray. Also, try rotating
the media 180° in the input tray.

For envelopes, this can be caused by air pockets inside
the envelope. Remove the envelope, flatten the
envelope, and then try printing again.

Toner scatter outline

If large amounts of toner have scattered around the
characters, the transfer of toner to the media is not
optimal. (A small amount of toner scatter is normal for
laser printing.) Try a different media type setting in the
printer driver, or use a different media type.

Turn over the stack of media in the tray.

Use media that is designed for laser printers.
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Moisture

$

NOTE: This product dissipates heat by using convective
AOBbCC cooling. The heat and moisture generated by the printing
AaBbCc process escape through vents in the product exterior or

through the output bin area.
AaBbCc

Verify normal product operation
AaBbCc

The release of moisture is a result of normal product operation.
AaBbCcC P Stooat

However, HP recommends using the following steps to verify

 AYOW B

that the product is releasing steam and does not have a
functional problem.

1. Turn the product off, and then on.

2. Send a print job to the product, and then verify that the
product is operating correctly.

3. When printing a job and vapor is visible, immediately
reprint the job using the same sheet of paper. There
should be either no visible vapor, or much less vapor
during the printing process.

Limit or reduce steam or vapor

o Make sure that the product is placed in a well-ventilated
area that meets the environmental specifications in this
guide. See Environmental specifications on page 106.

o Do not place the product, or store paper, near an outside
entrance where temperature changes can increase
humidity.

° Use an unopened ream of paper that has not been
exposed to high humidity.

e  Store paper in an airtight container, where it will be less
likely to absorb moisture.

Optimize and improve image quality

Change print density

You can change the print density setting by from the printer properties dialog box.

1.

86 Chapte

Windows XP, Windows Server 2008, and Windows Server 2003 (using the default Start menu
view): Click Start, and then click Printers and Faxes.

-or-

Windows XP, Windows Server 2008, and Windows Server 2003 (using the Classic Start menu
view): Click Start, and then click Printers.

-or-

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

In the list of printers, right-click the name of this product, and then click the Properties menu item
to open the printer properties dialog box.
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Click the Device settings tab, and then move the Print Density slider to the desired setting.

Click the Apply button to accept the setting, and then click the OK button to close the dialog box.

ENWW Solve image-quality problems 87



Solve performance problems

Problem

Cause

Solution

Pages print but are totally blank.

The cartridge pull tab or the sealing tape
might still be in the print cartridge.

Verify that the cartridge pull tab and tape
have been removed completely from the
print cartridge.

The document might contain blank
pages.

Check the document that you are printing
to see if content appears on all of the
pages.

The product might be malfunctioning.

To check the product, print a
Configuration page.

Pages print very slowly.

Heavier paper types can slow the print
job.

Print on a different type of paper.

Complex pages can print slowly.

Narrow or small media can print slowly.

Proper fusing may require a slower print
speed to ensure the best print quality.

Using the FastRes 1200 print quality
setting can cause slow printing.

1. Open the print driver, and then click
the Properties or Preferences
button.

2. Click the Paper/Quality tab, and
then use the Print Quality drop-
down list to select a lower resolution
setting.

3. Click the OK button or the Apply
button to accept the setting.

Pages did not print.

The product might not be pulling paper
correctly.

Make sure that paper is loaded in the tray
correctly.

The paper is jamming in the product.

Clear the jam. See Clear jams
on page 73.

The USB cable might be defective or
incorrectly connected.

o Disconnect the USB cable at both
ends, and then reconnect it.

e  Try printing a job that has printed in
the past.

e  Try using a different USB cable.

Other devices are running on the
computer.

The product might not share a USB port.
If you have an external hard drive or
switchbox that is connected to the same
port as the product, the other device
might be interfering. To connect and use
the product, disconnect the other device,
or use two USB ports on the computer.
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Solve connectivity problems

Solve direct-connect problems

If you have connected the product directly to a computer, check the USB cable.

e Verify that the cable is connected to the computer and to the product.

o Verify that the cable is not longer than 2 m (6.56 ft). Replace the cable if necessary.

o Verify that the cable is working correctly by connecting it to another product. Replace the cable if

necessary.

Solve wireless problems

ENWW

The installation program cannot detect the product during the setup process.

Cause

Solution

The product is off.

Verify that the product is on and ready. Restart the product if
necessary.

The product is too far away from the wireless router or access
point.

Move the product closer to the wireless router or access point.

A personal firewall program is blocking communication.

Temporarily disable the firewall program to install the product.
Re-enable the firewall program once the product installation is
complete. If disabling the firewall allows you to communicate
with the product, you might want to assign the product a static
IP address, and then re-enable the firewall. For information
about firewalls that are used in an HP environment, see
www.hp.com/support/XP_firewall_information.

The product is not communicating with the wireless router or
access point.

o Verify that the wireless () light is on. If it is not on, press
the wireless () button.

o Move the product closer to the wireless router or access
point, and then try again.

o Restore the default wireless settings.
a. Turn the product off.

b. Press and hold the wireless (i) button and the
cancel X button, and then turn the product on.

c. Hold the buttons until all the lights blink in unison,
and then release the buttons.

If the error persists, uninstall the product, and then re-run the
installer program. When prompted for network settings,
provide the settings, and then continue the installation.
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The product cannot connect to the wireless network.

Cause

Solution

The product wireless settings and the network settings do not
match.

You might need to configure the product network settings
manually. Verify that you know the following network settings:

e  Communication mode

o  Network name (SSID)

e  Channel (ad-hoc networks only)
e  Authentication type

Use the Wireless Configuration utility to configure the product
to print on wireless network.

If the error persists, uninstall the product, and then re-run the
installer program. When prompted for network settings,
provide the settings, and then continue the installation.

The wireless router or access point is configured with a media
access control (MAC) filter that is denying the product access
to the network.

Configure the wireless router or access point so that the list of
accepted MAC addresses includes the product hardware
address. Refer to the device owners manual for help.

The wireless connection is sometimes disabled.

Cause

Solution

The product environment might be affecting wireless
communication. The following situations can affect wireless
communication:

e A concrete or metal framed wall stands between the
product and the wireless router or access point.

e  Televisions, computer appliances, microwave ovens,
intercoms, mobile/cellular phones, battery chargers, and
AC power adapters are installed close to the network.

o A broadcast station or high-tension wire is located close
to the network.

e Afluorescent light that is near the network is being
switched on or off.

Move the product to a location where it can receive a steady
signal from the wireless router or access point. Or you might
need to move the wireless router or access point.
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Solve product software problems

Solve common Windows problems

Error message:
"General Protection FaultException OE"
"Spool32"

"lllegal Operation"

Cause

Solution

Close all software programs, restart Windows, and try again.

Delete all temporary files from the Temp subdirectory. To find
the Temp folder, complete the following steps:

1. Click the Start button, and then click the Run item.
2. Inthe Open box, type temp%.

3. Click the OK button. A Windows Explorer window for the
Temp folder opens.

See the Microsoft Windows documentation that came with the
computer for more information about Windows error
messages.

Solve common Macintosh problems

Table 8-3 Problems in Mac OS X

The printer driver is not listed in the Printer Setup Utility or the Print & Fax list.

Cause

Solution

The product software might not have been installed or was installed Make sure that the product .GZ file is in the following hard-drive folder:

incorrectly.

Mac OS X v10.4: Library/Printers/PPDs/Contents/
Resources/<lang>.lproj, where <lang> is the two-letter
language code for the language that you are using.

Mac OS X v10.5 and v10.6: Library/Printers/PPDs/
Contents/Resources

If necessary, reinstall the software. See the getting started guide for
instructions.

The Postscript Printer Description (PPD) file is corrupt.

Delete the .GZ file from the following hard-drive folder:

Mac OS X v10.4: Library/Printers/PPDs/Contents/
Resources/<lang>.lproj, where <lang> is the two-letter
language code for the language that you are using.

Mac OS X v10.5 and v10.6: Library/Printers/PPDs/
Contents/Resources

Reinstall the software. See the getting started guide for instructions.
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Table 8-3 Problems in Mac OS X (continued)

The product name does not appear in the product list in the Printer Setup Utility or Print & Fax list.

Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the ready light () is on.

The wrong product name is being used.

Print a configuration page to check the product name. Verify that the
name on the configuration page matches the product name in the
Printer Setup Utility or the Print & Fax list.

The interface cable might be defective or of poor quality.

Replace the cable with a high-quality cable.

The printer driver does not automatically set up the selected product in the Printer Setup Utility or the Print & Fax list.

Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the ready light () is on.

The product software might not have been installed or was installed
incorrectly.

Make sure that the product PPD is in the following hard-drive folder:

e MacOS Xv10.4: Library/Printers/PPDs/Contents/
Resources/<lang>.lproj, where <lang> is the two-letter
language code for the language that you are using.

e Mac OS Xv10.5 and v10.6: Library/Printers/PPDs/
Contents/Resources

If necessary, reinstall the software. See the getting started guide for
instructions.

The Postscript Printer Description (PPD) file is corrupt.

Delete the .GZ file from the following hard-drive folder:

e MacOS Xv10.4: Library/Printers/PPDs/Contents/
Resources/<lang>.lproj, where <lang> is the two-letter
language code for the language that you are using.

e Mac OS Xv10.5 and v10.6: Library/Printers/PPDs/
Contents/Resources

Reinstall the software. See the getting started guide for instructions.

The interface cable might be defective or of poor quality.

Replace the interface cable with a high-quality cable.

A print job was not sent to the product that you wanted.

Cause

Solution

The print queue might be stopped.

Restart the print queue. Open print monitor and select Start Jobs.

The wrong product name is being used. Another product with the
same or similar name might have received your print job.

Print a configuration page to check the product name. Verify that the
name on the configuration page matches the product name in the
Printer Setup Utility or Print & Fax list.
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Table 8-3 Problems in Mac OS X (continued)
You are unable to print from a third-party USB card.

Cause Solution
This error occurs when the software for USB products is not When adding a third-party USB card, you might need the Apple USB
installed. Adapter Card Support software. The most current version of this

software is available from the Apple Web site.

When connected with a USB cable, the product does not appear in the Printer Setup Utility or Print & Fax list after the driver is

selected.

Cause Solution

This problem is caused by either a software or a hardware Software troubleshooting

component.
[ ]

Check that your Macintosh supports USB.

Verify that your Macintosh operating system is Mac OS X v10.4
or later.

Ensure that your Macintosh has the appropriate USB software
from Apple.

Hardware troubleshooting

Check that the product is turned on.
Verify that the USB cable is connected correctly.
Check that you are using the appropriate high-speed USB cable.

Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

Check to see if more than two non-powered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain, and then connect the cable directly to the USB
port on the host computer.

NOTE: The iMac keyboard is a non-powered USB hub.
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A Supplies and accessories

° Order parts, accessories, and supplies

° Part numbers
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Order parts, accessories, and supplies

Order supplies and paper

www.hp.com/go/suresupply

Order genuine HP parts or accessories

www.hp.com/buy/parts

Order through service or support providers

Contact an HP-authorized service or support provider.

Part numbers

The following list of accessories was current at the time of printing. Ordering information and availability
of the accessories might change during the life of the product.

Paper-handling accessories

Item

Description

Part number

Pickup roller

Pickup roller for input tray

RL1-1443-000CN

Separation pad assembly

Separation pad for input tray

RM1-4006-000CN

Print cartridges

Item

Description

Part number

HP LaserJet print cartridge

Black print cartridge

See one the following items to determine
the print cartridge part number.

e  The configuration page
e  The supplies status page
e  The current print cartridge

e  www.hp.com/gol/ljsupplies

Cables and interfaces

Item

Description

Part number

USB cable

2-meter A-to-B cable

8121-0868
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HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet Professional P1100, P1100w One year from date of purchase

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace products
which prove to be defective. Replacement products may be either new or equivalent in performance to
new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when properly
installed and used. If HP receives notice of such defects during the warranty period, HP will replace
software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled
to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration,
(b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse,
(d) operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO
NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE
RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A
REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE
AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third Party
Licenses include licenses that provide for the availability of source code (such as the GNU General
Public License) and the corresponding source code is not included with the Software, then check the
product support pages of HP’s website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,
storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the
HP Software or disable any licensing or control feature of the HP Software. If this Software is provided
by HP for Use with an imaging or printing product (for example, if the Software is a printer driver,
firmware, or add-on), the HP Software may only be used with such product (“‘HP Product”). Additional
restrictions on Use may appear in the User Documentation. You may not separate component parts of
the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,
provided each copy contains all the original HP Software’s proprietary notices and is used only for back-
up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively
“Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for the
Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use such
HP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. In
case of a conflict between this EULA and such other terms, the other terms will prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the
HP Software to another end user. Any transfer will include all component parts, media, User
Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be an
indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the transferred
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Software will agree to this EULA. Upon transfer of the HP Software, your license is automatically
terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for commercial
timesharing or bureau use. You may not sublicense, assign or otherwise transfer the HP Software except
as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade secret,
patent, and trademark laws. You will not remove any product identification, copyright notice, or
proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s privacy
policy. HP will not use such information in a form that personally identifies you except to the extent
necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability of
HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to the
greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES (INCLUDING
DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION, PERSONAL INJURY,
OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states
or other jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with FAR
12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

(c) 2007 Hewlett-Packard Development Company, L.P.
Rev. 11/06
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Customer self-repair warranty service

HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.

Customer support

Get telephone support for your country/region Country/region phone numbers are on the flyer that was in the
box with your product or at www.hp.com/support/.

Have the product name, serial number, date of purchase, and
problem description ready.

Get 24-hour Internet support www.hp.com/support/ljp1100series

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic information www.hp.com/support/lijp1100series

Order additional HP service or maintenance agreements www.hp.com/go/carepack
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If HP Customer Care determines that your product needs to be returned to HP for repair, follow these
steps to repack the product before shipping it.

Shipping damage as a result of inadequate packing is the customer’s responsibility.
Remove and retain the print cartridge.

It is extremely important to remove the print cartridge before shipping the product. A
print cartridge that remains in the product during shipping can leak and cover the product engine
and other parts with toner.

To prevent damage to the print cartridge, avoid touching the roller on it, and store the print cartridge
in its original packing material or so that it is not exposed to light.

Remove and retain the power cable, interface cable, and optional accessories, such as an EIO
card.

If possible, include print samples and 50 to 100 sheets of paper or other print media that did not
print correctly.

Inthe U.S., call HP Customer Care to request new packing material. In other areas, use the original
packing material, if possible. Hewlett-Packard recommends insuring the equipment for shipment.

Repack the product 103
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C Specifications

° Physical specifications

° Power consumption, electrical specifications, and acoustic emissions

° Environmental specifications
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Physical specifications

Table C-1 Physical specifications’

Specification HP LaserJet Professional P1100 Printer series
Product weight 4.7 kg (10.4 Ib)

Product height 194 mm (7.6 in)

Product depth 224 mm (8.8 in)

Product width 347 mm (13.7 in)

1 Values are based on preliminary data. See www.hp.com/support/ljp1100series.

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/lip1100 regulatory for current information.

Environmental specifications

Table C-2 Environmental specifications

Operating’ Storage’
Temperature 10° to 32.5°C (50° to 91°F) 0° to 35°C (32° to 95°F)
Relative Humidity 10% to 80% 10% to 80%

1 Values are based on preliminary data. See www.hp.com/support/ljp1100series.
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D Regulatory information

° FCC regulations

° Environmental product stewardship program

° Declaration of conformity (base models)

° Declaration of conformity (wireless models)

e  Safety statements

° Additional statements for wireless products
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This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If this equipment is not installed and used in accordance with the instructions, it may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase separation between equipment and receiver.

Connect equipment to an outlet on a circuit different from that to which the receiver is located.
Consult your dealer or an experienced radio/TV technician.

E74 Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental product stewardship program

Protecting the environment
Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.
Ozone production

This product generates no appreciable ozone gas (Os).

Power consumption

Power usage drops significantly while in Ready or Auto-Off mode, which saves natural resources and
saves money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product, see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:

www.hp.com/go/energystar

Toner consumption

EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use

This product’s manual duplex feature (two-sided printing) and N-up printing (multiple pages printed on
one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies

It's easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with

HP Planet Partners. Multilingual program information and instructions are included in every new

HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

Bf NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to hitp://www.hp.com/

recycle.
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The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Package each HP LaserJet print cartridge in its original box and bag.

Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 Ib).

Use a single pre-paid shipping label.
OR

Use your own suitable box, or request a free bulk collection box from or
1-800-340-2445 (holds up to 31 kg (70 Ib) of HP LaserJet print cartridges).

Use a single pre-paid shipping label.

Package the HP LaserJet print cartridge in its original bag and box.

Place the shipping label on the front of the box.

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit . If you are returning via USPS label, give the package
to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For more information, or to
order additional labels or boxes for bulk returns, visit or call 1-800-340-2445.
Requested UPS pickup will be charged normal pickup rates. Information subject to change without
notice.

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal Service
provides no-cost cartridge return transportation services under an arrangement with HP for Alaska and
Hawaii.

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
. Select your country/region for information on how to return your HP LaserJet printing supplies.

This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.
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Material restrictions
This HP product does not contain added mercury.

This HP product does not contain a battery.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be found
at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.

For more information
To obtain information about these environmental topics:
e  Product environmental profile sheet for this and many related HP products
e HP’s commitment to the environment
e HP’s environmental management system
e HP’s end-of-life product return and recycling program
e  Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity (base models)

according to ISO/IEC 17050-1 and EN 17050-1; DoC#: BOISB-0901-00-rel.1.0

Manufacturer’s Name: Hewlett-Packard Company
Manufacturer's Address: 11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet P1100 Printer Series
Regulatory Model:? BOISB-0901-00

Product Options: All

Toner Cartridges: CE285A, CE284A, CE286A
conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11

IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN55022:2006 +A1:2007 - Class B"
EN 61000-3-2:2006
EN 61000-3-3:1995 +A1 +A2
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, and
carries the CE-Marking c € accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

Boise, Idaho 83713, USA

October 2009
For Regulatory Topics Only:

European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh, Department HQ-TRE / Standards
Europe, Herrenberger Stralle 140, D-71034 Boblingen, Germany, (FAX: +49-7031-14-3143), http://www.hp.com/go/
certificates

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, USA,
(Phone: 208-396-6000)
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Declaration of conformity (wireless models)

according to ISO/IEC 17050-1 and EN 17050-1; DoC#: BOISB-0901-01-rel.1.0

Manufacturer’s Name: Hewlett-Packard Company
Manufacturer's Address: 11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet P1100 Series
Regulatory Model:? BOISB-0901-01

Product Options: All

Radio Module 2 BOISB-0803-00

Toner Cartridges: CE285A, CE284A, CE286A
conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11

IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN55022:2006 +A1:2007 - Class B"
EN 61000-3-2:2006
EN 61000-3-3:1995 +A1 +A2
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

RADIO?): EN 301 489-1:V1.8.1 / EN 301 489-17:V1.3.2
EN 300 328:1.7.1
FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210

Supplementary Information:

The product herewith complies with the requirements of the R&TTE Directive 1999/5/EC Annex IV, EMC Directive 2004/108/EC and the Low
Voltage Directive 2006/95/EC, and carries the CE-Marking C € @ accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3) This product uses a radio module device which Regulatory Model number is BOISB-0803-00 as needed to meet technical regulatory
requirements for the countries/regions this product will be sold.

Boise, I[daho 83713, USA

October 2009
For Regulatory Topics Only:

European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh, Department HQ-TRE / Standards
Europe, Herrenberger Strale 140, D-71034 Boblingen, Germany, (FAX: +49-7031-14-3143), http://www.hp.com/go/
certificates

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, USA,
(Phone: 208-396-6000)
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Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

/A WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.

« Conforme a la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

COKEIR. FHRUBZEFEREEEIRHHER (VCC1) DEE
[TEILKYVSABERFMEETY, COEER, RERETERT S &
EZEMELTVETS, COEEBAICAPLTLES 3 URERITEELT
RIS L. ZRERFESICRCIEAHYET,

BRGAEIC S TELLRYFZDELTTEL,

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 110-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

/A CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)
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EMC statement (Korea)
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Luokan 1 laserlaite
Klass 1 Laser Apparat

HP LaserJet Professional P1100, P1100w, laserkirjoitin on kayttdjan kannalta turvallinen luokan 1
laserlaite. Normaalissa kaytossa kirjoittimen suojakotelointi estaa lasersateen paasyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on maaritetty standardin EN 60825-1 (1994) mukaisesti.

VAROITUS !

Laitteen kayttaminen muulla kuin kayttdohjeessa mainitulla tavalla saattaa altistaa kayttajan
turvallisuusluokan 1 ylittavalle nakymattdémalle lasersateilylle.

VARNING !

Om apparaten anvands pa annat satt an i bruksanvisning specificerats, kan anvandaren utsattas for
osynlig laserstralning, som 6verskrider gransen for laserklass 1.

HUOLTO

HP LaserJet Professional P1100, P1100w - kirjoittimen sisalla ei ole kayttajan huollettavissa olevia
kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkil6. Tallaiseksi
huoltotoimenpiteeksi ei katsota variainekasetin vaihtamista, paperiradan puhdistusta tai muita kayttajan
kasikirjassa lueteltuja, kayttajan tehtavaksi tarkoitettuja yllapitotoimia, jotka voidaan suorittaa ilman
erikoistyokaluja.

VARO'!

Mikali kirjoittimen suojakotelo avataan, olet alttiina nakymattdmallelasersateilylle laitteen ollessa
toiminnassa. Al katso sateeseen.

VARNING !

Om laserprinterns skyddshélje 6ppnas da apparaten ar i funktion, utsattas anvandaren fér osynlig
laserstralning. Betrakta ej stralen. Tiedot laitteessa kaytettavan laserdiodin sateilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.

Das Gerat ist nicht fir die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um stérende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.
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Additional statements for wireless products

FCC compliance statement—United States

A

A

Exposure to radio frequency radiation

CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure
limits. Nevertheless, the device shall be used in such a manner that the potential for human contact
during normal operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity
to the antenna shall not be less than 20 cm ( (8 in)) during normal operation.

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation of this
product without the express approval by Hewlett-Packard Company may invalidate its authorized use.

Australia statement

This device incorporates a radio-transmitting (wireless) device. For protection against radio transmission
exposure, it is recommended that this device be operated no less than 20 cm from the head, neck, or
body.

Brazil ANATEL statement

Este equipamento opera em carater secundario, isto €, ndo tem direito a proteg¢ao contra interferéncia
prejudicial, mesmo de estagdes do mesmo tipo, e ndo pode causar interferéncia a sistemas operando
em carater primario.

Canadian statements

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus as set out in the radio interference regulations of the Canadian Department of
Communications. The internal wireless radio complies with RSS 210 of Industry Canada.

Pour I'usage d’intérieur. Le présent appareil numérique n’émet pas de bruits radioélectriques
dépassant les limites applicables aux appareils numériques de Classe B prescribes dans le réglement
sur le brouillage radioélectrique édicté par le Ministére des Communications du Canada. Le composant
RF interne est conforme a la norme CNR-210 d’Industrie Canada.

European Union regulatory notice

ENWW

The telecommunications functionality of this product may be used in the following EU and EFTA
countries/regions:

Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany,
Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta,
Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.
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Notice for use in France

For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This equipment may be
used indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only

2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, see

www.arcep.fr.

L'utilisation de cet equipement (2.4 GHz Wireless LAN) est soumise a certaines restrictions : Cet

équipement peut étre utilisé a l'intérieur d'un batiment en utilisant toutes les fréquences de 2400-2483.5
MHz (Chaine 1-13). Pour une utilisation en environnement extérieur, vous devez utiliser les fréquences

comprises entre 2400-2454 MHz (Chaine 1-9). Pour les derniéres restrictions, voir, www.arcep.fr.

Notice for use in Russia

CywiecTByt0oT onpeferneHHble orpaHMYeHns No NCNonb3oBaHMIo 6ecnpoBoaHbIX ceTen (CTaHaapTa
802.11 b/g) c paboueir yactoTon 2,4 ITy: [JaHHOe obopynoBaHME MOXET MCNONb30BaTLCA BHYTPU
noMeLLeHui ¢ ucnosnb3oBaHneM amvanasoHa yactot 2400-2483,5 MI'y (kaHanb 1-13). Mpu
NCNONb30BaHUN BHYTPU NOMELLEHNA MakcumarnbHas apdekTuBHasa N3oTponHO—M3ny4aemasi
MoLHocTb (BNMM) pomkHa cocTaBnaTe He 6onee 100MBT.

Korean statement

g8l FHdH|= 28 F dOEd 7ts40| US
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accessories

ordering 95, 96

part numbers 96
acoustic specifications 106
address, printer

Macintosh, troubleshooting 92

altitude specifications 106
anticounterfeit supplies 50

batteries included 111
bin, output
features 3
jams, clearing 77
bins, output
capacity 34
blank pages
problem-solving 88

cables

USB, problem-solving 88
Canadian DOC regulations 114
canceling

printing 38
canceling a print request 38
cartridges

non-HP 50

part numbers 96

recycling 50, 109

storage 50

warranty 99
cautions i
change

pickup roller 55

separation pad 58
clean

pickup roller 61
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cleaning

exterior 65

media path 62

printer 61
clearing jams

locations 74
configuration page 46
connecting to the network 24
control panel

settings 11, 16

status-light patterns 70
conventions, document iii
counterfeit supplies 50
cover pages 19, 40
crooked pages 81
custom-size paper settings

Macintosh 19
customer support

online 102

repacking product 103

declaration of conformity 112,
113
demo page 46
disposal, end-of-life 111
document conventions i
dots per inch (dpi)
specifications 3
double-sided printing
Macintosh 20
paper loading orientation 35
See also duplex printing
dpi (dots per inch)
specifications 3
drivers
Macintosh settings 19
Macintosh, troubleshooting 91
paper types 34
presets (Macintosh) 19

quick sets (Windows) 39

settings 11, 12, 16, 17

Windows, opening 39
duplex printing

Macintosh 20

paper loading orientation 35

See also double-sided printing

EconoMode setting 49
electrical specifications 106
embedded Web server
Configuration page 47
HP Smart Install tab 48
Information tab 47
Networking tab 48
product status 47
Settings tab 48
shop for supplies 48
supplies status 47
support 48
using 47
end-of-life disposal 111
envelopes
loading orientation 35
environment specifications 106
environmental features 2
environmental stewardship
program 109
errors
software 91
European Union, waste
disposal 111
EWS. See embedded Web server

feeding problems, solving 81
Finnish laser safety
statement 115
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first page
use different paper 19
fraud hotline 50

General Protection FaultException
OE 91

HP Customer Care 102

HP fraud hotline 50

HP Smart Install tab (embedded
Web server) 48

humidity specifications 106

lllegal Operation errors 91
improve print quality 82
information pages

configuration page 46

demo page 46

supplies status page 46
Information tab (embedded Web

server) 47

input tray

capacity 34

features 3

loading priority feed slot 35
interface ports

types included 3
IP address

Macintosh, troubleshooting 92

manual configuration 28

jams
common causes of 73
locations 74
output-bin, clearing 77
preventing 80
tray, clearing 74

Japanese VCCI statement 114

Korean EMC statement 114

laser safety statements 114, 115
license, software 100
light patterns 70

link speed settings 28
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loading media
priority feed slot 35

Macintosh
driver settings 17, 19
drivers, troubleshooting 91
problems, troubleshooting 91
removing software 16
resize documents 19
support 102
supported operating
systems 16
USB card, troubleshooting 93
Macintosh driver settings
custom-size paper 19
managing network 27
material restrictions 111
Material Safety Data Sheet
(MSDS) 111
media
custom-size, Macintosh
settings 19
first page 19
pages per sheet 20
select size and type 32
supported sizes 33
media path, cleaning 62
mercury-free product 111
model number 6
multiple pages per sheet 20

n-up printing 20
network
IP address configuration 28
link speed settings 28
operating systems
supported 22
password, changing 27
password, setting 27
settings, changing 27
settings, viewing 27
network connection 24
Networking tab (embedded Web
server) 48
non-HP supplies 50
notes iii

online support 102

operating environment
specifications 106
operating systems supported 16
operating systems Windows,
supported 10
operating systems, networks 22
ordering
part numbers for 96
supplies and accessories 96
ordering supplies

Web sites 95
orientation

paper, while loading 35
output bin

capacity 34

features 3

output quality. See print quality

packaging product 103
pages

blank 88

not printing 88

printing slowly 88
pages per sheet 20
pages, skewed 81

paper
covers, using different
paper 40

custom size, selecting 40
custom-size, Macintosh
settings 19
first and last pages, using
different paper 40
first page 19
loading orientation 35
pages per sheet 20
size, selecting 40
supported sizes 33
supported types 34
type, selecting 40
paper handling
problem-solving 81
paper input tray
features 3
paper input trays
feeding problems, solving 81
paper jams. See jams
paper output bin
features 3
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paper, ordering 96
part numbers
print cartridges 96
pausing a print request 38
physical specifications 106
pickup roller
change 55
clean 61
ports
troubleshooting Macintosh 93
types included 3
power
consumption 106
problem-solving 68
presets (Macintosh) 19
print cartridges
non-HP 50
part numbers 96
recycling 50, 109
redistributing toner 51
storage 50
warranty 99
print density 86

print media
supported 33

print quality
creases 85
curl 85

dropouts 83
gray background 83
improve 82
light or faded print 82
loose toner 84
misformed characters 84
moisture on trailing edge 86
page skew 84
problem-solving 82
specifications 3
steam or vapor from the
product 86
toner scatter outline 85
toner smear 83
toner specks 82
vertical lines 83
vertical repetitive defects 84
wave 85
wrinkles 85

print tasks 37

printer
cleaning 61
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printer information pages
configuration page 46
demo page 46
supplies status page 46
printing
configuration page 46
demo page 46
problem-solving 88
supplies status page 46
priority feed slot
loading 35
priority, settings 11, 16
problem-solving
blank pages 88

direct-connect problems 89

output quality 82
pages not printing 88
pages printing slowly 88
paper handling 81
status-light patterns 70
USB cables 88
Windows issues 91
wireless problems 89
See also solving

product
software for Windows 9
view 4

quality
specifications 3
quick sets 39

recycling

HP printing supplies returns and
environmental program 110

recycling supplies 50
redistributing toner 51
removing Macintosh software
removing software

Windows 13
repacking product 103
resize documents

Macintosh 19
resolution

problem-solving quality 82

specifications 3

safety statements 114, 115

scale documents
Macintosh 19
separation pad
change 58
serial number 6
service
repacking product 103
settings
driver presets (Macintosh) 19
drivers 12, 17
priority 11, 16
Settings tab (embedded Web
server) 48
shipping product 103
size specifications, product 106
size, media
tray selection 32
skewed pages 81
software
embedded Web server 14,
18
problems 91
settings 11, 16
software license
agreement 100
supported operating
systems 16
supported Windows operating
systems 10
uninstalling for Windows 13
uninstalling Macintosh 16
solving
creases 85
curl 85
direct-connect problems 89
dropouts 83
feeding problems 81
gray background 83
light or faded print 82
loose toner 84
misformed characters 84
moisture on trailing edge 86
page skew 84
skewed pages 81
steam or vapor from the
product 86
toner scatter outline 85
toner smear 83
toner specks 82
vertical lines 83
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vertical repetitive defects 84 tray

wave 85 features 3
wireless problems 89 jams, clearing 74
wrinkles 85 Tray1 20
See also problem-solving trays
special media capacity 34
guidelines 31 double-sided printing 20
special paper loading 35
guidelines 31 paper orientation 35
specifications troubleshooting
device features 3 Macintosh problems 91
electrical and acoustic 106 See also solving; problem-
environment 106 solving
physical 106 troubleshooting checklist 68
Spool32 errors 91 types, media
status-light patterns 70 tray selection 32
stopping a print request 38
storing
print cartridges 50 uninstalling
product 106 Windows software 13
supplies uninstalling Macintosh
counterfeit 50 software 16
non-HP 50 uninstalling Windows
ordering 95, 96 software 13
part numbers 96 USB cable, part number 96
recycling 50, 109 USB port
supplies status page 46 problem-solving 88
support troubleshooting Macintosh 93
online 102 type included 3

repacking product 103

supported media 33
view, product 4

TCP/IP
operating systems warnings i
supported 22 warranty
technical support customer self repair 102
online 102 license 100
repacking product 103 print cartridges 99
temperature specifications 106 product 98
tips i Web sites
toner customer support 102
loose toner 84 fraud reports 50
low 82 Macintosh customer
redistributing 51 support 102
scatter outline 85 Material Safety Data Sheet
smear 83 (MSDS) 111
specks 82 ordering supplies 95
toner cartridges. See print Windows
cartridges driver settings 12

problem-solving issues 91
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